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Getting Started in InDesign

Before opening InDesign, make sure you have installed the Twixl Publisher plug-in
according to these instructions.

When you have started InDesign, select the Window menu, then navigate to Extensions
-> Twixl Publisher to open the palette. You will notice a number of options are available in
the palette.

If no object is selected in InDesign, the publication management options will be available.

If a certain object (like a movie or image) is selected, depending on the type of object,
the relevant options for different interactive elements will be displayed.

¢ Twix| Publisher 15.3

Publication Article

Properties Publication

Preview Publication Article

Publication Article

Publication Article

Separate Articles

Alternate Layouts

Preferences

Twixl Publisher offers two different approaches to creating your content:

1. Article-based
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Create individual articles that can be uploaded to a collection on the Twixl platform -
this works best when multiple designers are working on content for the same app, or
when you have an app with frequently updated content.

2. Publication-based

Create a complete publication, using an InDesign book to manage the different
articles - this works best if only one designer is working on the publication. When
importing a Twixl publication to an app on the platform, it will automatically be split
into a collection with individual articles for each of the InDesign documents.

You can decide to create and export individual articles separately. When you export an
article, the exported file will have the extension .article.

Just zip that .article file, and it can be uploaded to the platform.

For more details about adding content to your app, please check Working with Content
ltems.

Twixl Publisher supports 4 different sizes, each of them in landscape and portrait:

- iPad (1024x768 and 768x1024 pixels)

« Android 10 inch (1280x752 and 752x1280 pixels)

« Android 7 inch - Kindle Fire (1024x552 and 552x1024 pixels)
+ Phones (568x320 and 320x568 pixels)

For iPad reting, a scaled 2048x1536 and 1536x2048 version will automatically be
generated when exporting. For phones, 3 renditions will be generated.

New articles or publications created by the Twixl Publisher plug-in will use a specific
naming convention for the alternate layouts:

« iPad: "iPad H' for landscape and “iPad V" for portrait

« Android 10 inch: "Android 10" H" for landscape and "Android 10" V" for portrait

- Android 7 inch: "Kindle Fire/Nook H" for landscape and "Kindle Fire/Nook V" for portrait
« Phones: "Phone H' for landscape and "Phone V' for portrait

@ IMPORTANT NOTE:

If you create documents manually, i.e. by selecting New Document from the File
menu instead of using the plug-in's ‘New article’ menu option), make sure your
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alternate layouts use the naming convention above, and that your documents
have the page size Twixl Publisher expects. If you have layouts with a different
name, you'll receive an error message durning preflight.

Publication Properties

Name | AvantGand
TOC Viewer Title Bar Button
Initial Article
Template iPad Landscape
File Name | Table of Contents
Title

Tag Line

Show Templates Folder...

Select "New Publication”. Once you select a publication name and optional issue number,
the plug-in will create a "book” in InDesign.

An InDesign book file is a collection of documents that can share styles, swatches,
master pages, and other items.

There are two options for displaying your Table of Contents (TOC):

« Title Bar Button (default)
« If you do not want to display a TOC viewer at all, select the option "None®

If you choose "Title bar button..” a TOC icon will appear in the right corner of the title bar,
that will become visible when tapping anywhere on a page of your publication. If you
also defined a hamburger menu in your app, it will appear to the left of that menu.
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Hospitality special

INTRO

% HOTELROOMS
@ WELLNESS

CONFERENCE AND MULTIFUNCTIONAL AREAS
@ BAR AND RESTAURANT

i @ OUTDOOR AREA

[
VELTRIESS JBESTRI

Initial article

Here, you can already create the first article of your publication, as well as select its title
and optional tagline (these will be displayed in the TOC Viewer).

You can also select your starting template. The template you select for your first article
will become the default template for that publication.

Create in InDesign Page7



TI.I.IIXL LEARN & SUPPORT

Creating articles

Every article in your publication will be a single InDesign document. You can create
documents consisting of one or more pages, or alternatively you can create long
pages of any length.

ARTICLE1 ARTICLE 2 ARTICLE 3
(2 pages) (1 paga) (3 pages)
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« Any article can consist of one or more "pages”, and you'll be able to navigate from one
to the other on the iPad via vertical swiping.

+ Horizontal swiping from within any page of an article will always navigate to the first
page of the next article.

« If you check the publication option 'Horizontal swiping only', then all pages from the
different documents can only be navigated horizontally, independent of how you
organized them in InDesign.
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ARTICLE1 ARTICLE 2 ARTICLE 3
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You can also opt to have a page with the correct width, but with a length of your
choosing, similar to a web page. That way, instead of navigating vertically from page to
page, a user can continuously scroll through a longer document.

@ IMPORTANT NOTE:

If you work with long pages), you are limited to one page per article.

Select "New article” from the Twixl Publisher palette (if you are using a publication-based
workflow, a new InDesign document will be added to the book file).

© IMPORTANT NOTE:
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While it is always recommended to use the Twixl Publisher plug-in panel to
create new articles, sometimes you may have legacy content that you want to
re-use. In that case, make sure to check out the article "Page sizes".

New Article

Publication

File Name | No Publication Open

File Properties

Template |iPad Landscape v

Article Properties
Title

Tag Line
Author

Article URL

Article Options
Show Article in TOC Viewer

Show Templates Folder...

Select one of the included templates to start your design.

The "File name” will be used to name your InDesign document.

The "Title" is an optional title that will be displayed in the thumbnail viewer or in the
Table of Contents overview.

The "Tag Line" is an optional extra line of information that will be displayed in the Table
of Contents overview below the Title.

The "Author” is exactly that.

Article Options: "Show article in TOC": allows you to select whether the thumbnail for
this article will be visible in the Table of Contents overview.

If you are using a book, articles can be reordered to change the order in which they
will appear on the tablet. If you want to change the properties for your article
afterwards, select "Article Properties” from the Twixl Publisher palette.
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“Templates..”: You can create templates for your designs. Twixl Publisher templates
should be saved as InDesign template files (indt) and should be stored at one of the
following locations:

~/Library/Application Support/Twixl Publisher Plugin/Templates/ (user level)
(navigate to this folder using the "Templates” button in the "New Article” window)
/Library/Application Support/Twixl Publisher Plugin/Templates/ (rootlevel)

A number of alternate layout templates will automatically be installed. The alternate
layouts used in the templates use a specific naming convention. Check the "Working with
alternate layouts” section for more details.

There is nothing to configure in order to support standard resolution iPads as well as
retina iPads. The plug-in automatically and transparently generates the artwork for the
retina iPad in addition to the artwork for the standard resolution iPads. You just create
your design at 768x1024 (portrait) and 1024 x 768 pixels (landscape), but the only
requirement is that in order to obtain the optimal resolution for retina iPads as well, your
images should have an effective ppi of 144 (you can check this in the link info panel).
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If you are creating content for phones, note that you should have an effective ppi of 280
in order to obtain the optimal output quality. The Twixl Publisher preflight process will
generate a warning if your images have a lower resolution.

Create in InDesign Page 12
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Working with alternate layouts

With Twixl Publisher and InDesign, you can take advantage of the liquid layout/
alternate layout options. When using alternate layouts, we recommend starting your
design based on a single layout format, e.g. iPad Landscape. You can then define the
liquid layout options for each of your pages.

A PREREQUISITES:

Using the Twixl Publisher Alternate Layout functionality requires that you know the
concepts of Liquid layouts and Alternate Layouts in InDesign.

1. Start by creating a new publication.

2. Once your design is more or less complete for the form factor you started with, and if
you have set liquid layout rules for your objects, then the "Alternate Layouts.." option in
the main view of the plug-in allows you to generate different versions for all your
articles automatically.
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Twixl| Publisher 15.3

Publication Article
Properties Publication Article
N Publication Article
Publication Article

Publication Article

Separate Articles

Alternate Layouts

Preferences

Publication

File Name @ Avantgand.indb

Select the alternate layout(s) to create

[J Create "Kindle Fire/Nook H (Android 7")" in 17 of 17 articles

[ Create "Kindle Fire/Nook V (Android 7")" in 17 of 17 articles

Options
Link Stories

Copy Text Styles to New Style Group

E.g. if your first layout was iPad landscape, you will now be able to create the different
alternate layouts automatically, in a single click, for all articles in your publication.

The plug-in will detect which articles already have alternate layouts defined, and will only
offer to add them to those documents where they are not yet available.
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New articles or publications created by the Twixl Publisher plug-in will use a specific
naming convention for the alternate layouts:

« iPad: irad H forlandscape and irad v for portrait

« Android10inch: Android 10" # forlandscape and Android 10" v for portrait

« Android7inch: kKindle Fire/Nook H'forlandscape and Kindle Fire/Nook V for
portrait

« Phones: prhone H forlandscape and Phone Vv for portrait

@ IMPORTANT NOTE:

If you create documents manually (and not from the plug-in's ‘New article’' menu
option), make sure your alternate layouts use the naming convention above. If
you have layouts with a different name, the preflight will generate an error. See
also the article "Page sizes".

Q TIP:

If you want to create two Android layouts for both 10" and 7" versions, the best
approach is to first create the Android 10" alternate layout based on the iPad

layout, then make adjustments for the different aspect ratio, and once you're
happy with the Android 10" layout, you can generate the 7" version that will be
based on that.

Creating Alternate Layouts is a cumbersome process. It requires both time and
manpower. A lot of publishers decide to support only one Orientation (either Portrait or
Landscape) and that's perfectly understandable. If you do that, we advise you to follow
these guidelines:

« Think before you choose which Orientation you'll support: Landscape Only designs
are better suited if you have a lot of full screen Web Overlay Buttons or photos. Portrait
Only layouts are more popular on smartphones.

+ Go for dummy-content: It's always a good idea to provide your reader with extra
instructions, telling them to rotate their device so they can see the content!

Create in InDesign Page 15
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A ABOUT ANDROID TABLETS:

If an Android device has a screen ratio of 4:3, the iPad version will be shown (if
provided). If the device has another aspect ratio, the Android version will be
used.

Create in InDesign Page 16
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Page Sizes

When you create articles in Twixl Publisher, the alternate layouts are expected to be
of a specific size. Here's an overview:

Alternate Layout Landscape Portrait
iPad 1024 x 768 px 768 x 1024 px
Android 10" 1280 x 752 px 800 x 1232 px
Android 7° 1024 x 552 px 600 x 976 px
Phone 568 x 320 px 320 x 568 px

If you create new articles directly from the Twixl Publisher panel, these sizes will be used
automatically. If you want to create long pages, then you can always adjust the height,
but the width needs to be as specified in the diagram above.

Q TIP:

The maximum height for a long page is 14400 px for tablets and phones (the
Twixl Publisher Preflight will warn you if the Maximum Page Size exceeds the limit).

Don't exaggerate with long pages, because you don't want your reader to "get
lost” while reading!

If you want to adapt existing content of a different size for use with Twixl Publisher, you will
need to:

Create in InDesign Page 17
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+ Set up the alternate layout name correctly (i.e."iPad V", "iPad H", "Android 10" V",
"Android 10" H", "Kindle Fire/Nook V", "Kindle Fire/Nook H", "Phone V", "Phone H")

+ Use the pages panel to change the page size

Create in InDesign Page 18
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Creating content for phones

In Twixl Publisher, you can create an alternate layout for phones. To do this for an existing
document, open your publication, then click the ‘Alternate layouts” option in the plug-in
and you'll have an extra option to create a "Phone V" and a "Phone H" version of your
content. If you only want to create a phone layout in a new article, select the 'Phone
Portrait’ or Phone Landscape’ template.

@ IMPORTANT NOTE:

Do not use Adobe's built-in alternate layout “iPhone” from the Pages panel. Use
the Twixl Publisher plug-in panel to create the "Phone V" and "Phone H" versions
instead.

Article

File Name | Alternate Layouts Example.indd

Select the alternate layout(s) to create

[ Create "Android 10" H"

[J Create "Android 10" V"

[ Create "Kindle Fire/Nook H (Android 7")"
[ Create "Kindle Fire/Nook V (Android 7")"
Create "Phone H"

Create "Phone V"

Options
Link Stories

Copy Text Styles to New Style Group

Create in InDesign Page19
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The "Phone V" alternate layout is 320 pixels wide and 568 pixels long. The "Phone H" is 568
pixels wide and 320 long.

When exporting, the Twixl Publisher plug-in will automatically generate three renditions of
the phone version:

- 640 x 1136 / 1136 x 640 pixels (for iPhone 4/4S, 5/5S)
- 750 x 1334 [ 1334 x 750 pixels (for iPhone 6-12 Pro)
* 1242 x 2208 [ 2208 x 1242 pixels (for iPhone 6 Plus to 12 Pro Max)

For Android phones, the image dimension closest to the screen resolution will be used,
with a preference for scaling down instead of scaling up.

If you are creating content for phones, note that you should have an effective ppi of 280
in order to obtain optimal output quality on an iPhone 6 Plus.

Twixl publications uploaded to the Twixl Distribution Platform will be split automatically
into separate versions for the different platforms (iPad, iPad retina, Android 10" & Android
7", and 3 sizes for phones).

You can check if you uploaded a publication that supports all the platforms by checking
the file sizes of the publication.

The advantage is that a reader will only need to download the contents relevant for his
device.

When exporting a 'Phone’ layout from InDesign, Twixl Publisher will automatically
generate different phone resolutions based on the iPhone 5/5S, iPhone 6 to 12 Pro and
iPhone 6 Plus to 12 Pro Max formats. For Android phones, Twixl Publisher will automatically
select the version that is the closest to one of these three formats.
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On the Twixl platform, the Build for option in the build settings for your app offers three
choices:

+ Tablets (only)
« Phones (only)
« Tablets & Phones (universal)

This let you decide which type of app you want to create.

@ IMPORTANT NOTE:

Building for phones requires that your InDesign export contains a Phone alternate
layout. Also, if you submit a universal iPhone/iPad app to Apple, it is not possible
to later update this to a Tablet only or Phone only version.
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InDesign interactivity

Create in InDesign Page 22
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Buttons

Add actions to objects

Action buttons can be created via the Window -> Interactive -> Buttons and Forms.

When you convert an object to a button, an action can be attached to it. The event type

should be On Release or Tap.

The actions that can be attached to a button are shown in the screenshot below:

¢ Buttons and Forms Bookmarks

~ PDF Options

Go To Destin_ation

Go To First Page

Go To Last Page

Go To Next Page

Go To Previous Page
Go To URL

Show/Hide Buttons and Forms

Sound
Video

Animation

Go To Page

Go To State

Go To Next State

Go To Previous State

Clear Form

Go To Next View

Go To Previous View
Open File

Print Form

Submit Form

View Zoom

@ IMPORTANT NOTE:
Only a specific number of options in the Action menu are supported by Twixl

Publisher, i.e.:

« Go To First Page
+ Go To Last Page
+ Go To Next Page

Create in InDesign
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« Go To Previous Page

+ Go To URL

» Play a Sound

« Play a Video

+ Go To Page

« Go To State (of a multi-state object - slide show)
+ Go To Next State

« Go To Previous State

Buttons appearances are supported in Twixl Publisher if you use the “button
appearances” in the “buttons and forms” panel.

The Twixl Publisher plug-in will look at the Normal and Click states. If you have defined
these two button states, you will see that in the Twixl reader software, they work as a
“toggle” button. Everytime you tap the button, it toggles from the "Normal” to the "Click”
state and back.

Q TIP:

It is recommended to always add a Click State, even if they have the same look.
Buttons without a Click State defined, can result in problems with unresponsive
Actions.

We allow you to create a special type of button, called "Web Overlay Button’, that will
trigger a modal web viewer to be displayed on top of your page.

Create in InDesign Page 24
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Hyperlinks

Add links to text or objects.

Hyperlinks can be defined in InDesign via the Window -> Interactive ->
Hyperlinks palette.

Three types of hyperlinks are supported:

« Page link
* URL link
* Email link

¢ Hyperlinks ‘
New Hyperlink...

URL:  http://

Name Convert URLs to Hyperlinks...

New Hyperlink Destination...

Sort >

Small Panel Rows
v Auto Update URL Status

Select the object or highlight the text you want to define as a link, then choose "New
Hyperlink.." from the palette.

Note that page hyperlinks from portrait pages have to navigate to another portait page,
and hyperlinks from landscape pages have to navigate to another landscape page.
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Page Link
URL link
Opening a hyperlink in the device browser

Integrate embedded web content
Custom URL schemes

Mail link

R B N S I N

You can create a hyperlink that refers to any page within your book (i.e. publication).
Page hyperlinks from portrait pages have to navigate to another portait page, and
hyperlinks from landscape pages have to navigate to another landscape page.

New Hyperlink

Link To: |Page

Cancel

Destination
Document: TOC.indd

Page: 1

Zoom Setting: Fixed

Accessibility
Character Style

sy -

PDF Appearance
Type: | Invisible Rectangle v

Highlight: None v Width: Thin

Color: [WEEES ~ Style: Solid

You can create a hyperlink that links to an external URL. On the tablet, tapping such a link
will open a browser popup window for that URL within the app. Once the user has finished
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using the browser, tapping the "Done" button of the browser popup will bring the app
back to the foreground.

Link To: URL

Destination

URL:  https://twixImedia.com

[JJ Shared Hyperlink Destination

Accessibility
Character Style

W Hyperlink ~

PDF Appearance
Type: Invisible Rectangle
Highlight: None v Width: Thin

Color: L HEES v Style: Solid

Although in most cases, you want to keep readers in the embedded browser, sometimes
you may want to open a link directly in Safari on iPad or in the default browser on
Android. A good use case for this is if you want to link to a PDF that you want readers to
be able to download.

You can do this by adding an extra parameter to your URL:
tp-open-in-device-browser=1

The URLs below will open in the embedded app browser:

* http://www.website.com/file.pdf?id=1
* http://www.website.com/file2.pdf

And these will open in the device browser:

* http://www.website.com/file.pdf?id=1&tp-open-in-device-browser=1
* http://www.website.com/file2.pdf?tp-open-in-device-browser=1
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Embedded content will always be available, even when a user is offline.

All local content, including assets, JavasScript, etc.,, should be placed in a WebResources
folder within the folder where your InDesign book or document is located. The folder will
be created by the plug-in automatically. Note that the contents should not be zipped,
and should be placed there as is. You can organize several embedded hyperlinks by
creating different subfolders in the WebResources folder.

Once you have copied all your html content and assets to that location, enter the
Destination URL in the hyperlink field as shown below:

webresource://index.html

webresource://subfolder/index.html

Twixl Publisher supports a wide range of custom URL schemes for triggering specific
functions in your apps. Check the article below for more details about this:

» Custom URL schemes for Twixl apps

You can create a hyperlink that links to an email address with an optional subject.
Tapping such a link in the app will open a mail popup window to that email address and
optional subject. Once the e-mail has been sent, the app returns to the foreground.
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Link To: Email

Destination
Address: info@twixlmedia.com

Subject Line: Twixl Puvlisher Feedback

[J Shared Hyperlink Destination

Accessibility
Character Style

NI Hyperlink v

PDF Appearance
Type: Invisible Rectangle v

Highlight: | None v Width: Thin

Color: L EEES v Style: Solid

Q TIP:

For more advanced info about mail links, see this article: Mailto hyperlinks

@ IMPORTANT NOTE:

If you want to turn text information into a hyperlink, it may seem logical to select
the text in the text block, then turn it into a hyperlink. Depending on the point size
of your text however, you may decide to place a transparent rectangle on top of
the text and attach the hyperlink to that, so you can be sure the tap target is big
enough (Apple recommends a minimum size of 44 x 44 pixels for such targets).
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Images

Allow full-screen viewing of images

Place your image and you'll notice that the Twixl Publisher palette will offer the option to
assign an interactive element to that image. The only option available for image frames
in InDesign is Full Screen Image.

Twixl Publisher 15.3

4 ASSIGN ELEMENT

The element you've selected can be used for different types
of interactive elements. Please select the type of interactive
element you want to use:

Full Screen Image

Selecting this option will allow a reader to view the image in full-screen by double-
tapping.
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Twixl Publisher 15.3

4 IMAGE

v Allow Full Screen View

Unassign As Image
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Image Sequences

Add 360° views or other types of Image Sequences.

The Image Sequence option lets a user walk you through a series of images while
swiping. The most frequent application for this is to give a 360° view of an object.

* You can use a series of images (either JPG or PNG) that have the same root name
with a numbered suffix, e.g. bicycle_001.jpg, bicycle_002.jpg, etc.

« In order to get the best performance when rotating, you should use a series of at least
30 images. Do keep in mind, however, that using too many images may have an
impact on performance.

» Use PNG files only if you are using transparency in your images

» Make sure your images have the exact size as they will be displayed on the iPad

« In order to add optimized images for the retina iPad, make sure you folder contains
both versions for the standard resolution, e.g. bicycle_001.jpg.. as well the one for the
retina iPad that has the "@2x" suffix (e.g. bicycle _001@2x.jpg)

To create an image sequence object, create a rectangle the size of your images, then
select the Image Sequence palette.

In the palette, select the folder that contains the images of your sequence.
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¢ Twixl Publisher 15.3

4 IMAGE SEQUENCE

Folder containing the sequence of images:

ImageSeq

o v Play In Reverse
e v Allow Swiping to Change Images
Tap to play/pause
Auto Play
Speed (fps)
Delay (sec)
o v Allow Looping

Unassign As Image Sequence

1. Play In Reverse: This will change the rotation direction.

2. Allow Swiping to Change Images: Controls whether the reader can change the state

of the Image Sequence by Swiping.

3. Auto Play: Will start the Image Sequence automatically after the reader navigates to
this page. You can determine the Speed (in frames per second) and the Delay (in

seconds).

4. Tap to play/pause: Allows a user to start/stop automatic playback of an Image

Sequence.

5. Allow Looping: This will play the series of images in a continuous loop.
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Panorama VR

Add 3D VR walkthroughs.

A panorama VR lets you view a complete environment in 360°, but also lets you tilt so you
can e.g. also have a look at the sky and at the floor within that environment.

Here you can see some examples.

The basic steps to integrate a Panorama VR in your InDesign article or publication are the
following:

1. Create your panorama image (e.g. in Photoshop or with a special camerq, ...).

2. Download and install Pano2VR. This is not a free product but you can download a free
trial. Then later, depending on your needs, you can purchase a Standard or Pro
license.

3. Open your panorama image in Pano2VR and follow these basic workflow steps to get

HTML5 output.

Put your complete HTML5 output in a separate folder in your WebResources folder.

5. Create a Web viewer or a Web overlay button and link to the index.html file of your
HTML5-export.

»

O IMPORTANT NOTE:

Panorama VR functionality on Android is tricky. While it may work on most recent
devices (also the gyroscope functionality), we cannot guarantee a wide
compatibility across all devices because of the multitude of different hardware
and browser specifications.
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Scrollable Content

Add scrollable text blocks and zoomable images

The 'Scrollable content’ option allows you to add scrollable content to a container frame
with the following steps:

1. Create a text frame for the full length of the text.

2. Create a container of the size you want using the Rectangle Frame Tool.

3. Cut the text frame and then select 'Paste into' to Paste that text into the smaller
container frame.

The same applies to adding image content to the frame.

Twixl Publisher 15.3

4 SCROLLABLE CONTENT

o v Allow Scrolling
e v Show Scrollbars (unsupported on Android)
é v Zooming Enabled

Unassign As Scrollable Content

1. Allow Scrolling: Select this option to turn the current frame into scrollable content.

2. Show Scroll Bars: Show scroll bars when a user scrolls through the content.

3. Zooming Enabled: This option will allow the reader to use pinch & zoom to zoom in
and out.
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@ IMPORTANT NOTE:

If you want to make an image zoomable, make sure to place it in the frame at
the maximum zoom-in size that you want to allow. It will be scaled to fit in the
frame.

¢ MAXIMUM DIMENSIONS:

The maximum size of Scrollable Content items is limited. For phones: 8400 x 8400
px. For tablets: 15000 x 15000 px. The Twixl Publisher Preflight will warn you if you
exceed those limitations in your designs.
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Slide Shows

Use multi-state objects to create Slide Shows in a 2-step process:

1. First you'll create a multi-state object that contains the different images ("slides")
of your slide show
2. Then you'll set the different display options in the Twixl Publisher palette

A multi-state object for your slide show can be created via the Window -> Interactive ->
Object States palette.

To create a multi-state object, place a number of images in your document and align
them in a stack. then select them all, and click the "New" button in the Object States panel
to create a multi-state object. You can also change the order of the images in the slide
show.

Object States

Object Name:  Under The Surface - Landsc ey

=l ‘ State 1

.= State 2
i

‘ State 3

[®1 All states selected

¢ TIP: OBJECT STATES ASSISTANT (FREE TOOL)

If you want to have extra tools at your disposal to work with Multi-State Objects,
we suggest you have a look at this free tool: Object States Assistant.

Object States Assistant is a script that provides a more efficient and effective way
of working with multi-state objects in InDesign
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Object States Assistant (OSA) adds new functionalities to the Object States panel
and improves the user experience. OSA improves states navigation, it also allows
you to add objects to specific states, as well as remove and release multiple
states in a single operation.

« Improves state navigation by using menu items or keyboard shortcuts

« Adds objects to all states in a single operation.

« Adds objects to multiple states in a single operation.

« Pastes objects into all states in a single operation.

« Removes multiple states in a single operation.

* Releases multiple states in a single operation.

* Retains the “State” actions after Copy and Paste.

« Adds an easy way to increment the state of a “Go to State” button action using
“Step and Repeat”.

After you have created a multi-state object, the relevant interactive options can be
accessed from the Slide Show part of the Twixl Publisher palette.

Twixl Publisher 15.3

4 SLIDE SHOW

Duration (sec) _

Show Scroll View Indicator

Active Page -

Inactive Page -

Background

Opacity (%)

Allow Full Screen View
Background Color
a Tap to play/pause

e Auto Play

Interval (sec)

Delay (sec)
e v Play In A Loop

1. Analytics Name: Allows you to add a trackable name for the Slide Show.
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w

Transition Style: Allows you to select a transition when changing slides.

Duration: Sets the duration of the transition in seconds.

Show Scroll View Indicator: Shows page indicators - i.e. when you select this option a
semi-transparent layer will be added at the bottom of your slide show to indicate the
number of pictures. You can control the look of this layer by selecting the background
color and its opacity, as well as the active and inactive page colors.

Allow Swiping To Change States: Controls whether a user can scroll through the slide
show.

Allow Full Screen View: Double-tapping a slide show toggles a full screen view of the
slide show. Keep in mind that if you want to provide a full screen slide show, the
images should be available at a full screen resolution, i.e. more or less 132 ppi at a 1024
X 768 resolution.

Tap to play/pause: Allows a user to start/stop automatic playback of a slide show.
You can change the default interval of 3 seconds, and select the "Loop” option to have
a continuous playback of the slide show as long as the user remains on the same
page.

Auto Play: Will start the slide show automatically after the user navigates to this
page. You can change the default interval of 3 seconds (must be a minimum of 0.1
seconds), define a delay if you do not want the slide show to start immediately,

and select the "Loop” option to have a continuous playback of the slide show as long
as the user remains on the same page.

Play In A Loop: This option is available only when "Tap to play/pause” or "Auto Play” are
active. It provides a continuous playback of the slide show as long as the user
remains on the same page.
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Video

Easily add movies.

A ABOUT PREVIEWING PUBLICATIONS/ARTICLES WITH VIDEOS ON I0S DEVICES

Sometimes large movies (in terms of file size) can be missing when executing a
Preview on an iOS device (with the Twix! Viewer Classic). For a workaround, see

this article.

Movies can be embedded in the publication via the Window -> Interactive ->
Media palette.

You can add a video clip encoded in H.264 format.

Due to a limitation in InDesign, video files need to have the extension .mp4 and not
.m4v . If you have H.264 encoded files with the .m4v extension, you can just change the
extension from .m4v to .mp4.

@ IMPORTANT NOTE:

Make sure your files are encoded at a quality optimized for mobile devices, so
that they are not unnecessarily too big, preferably not larger than 1080 pixels
wide. Also make sure that the bitrate of your video is not too high. The (sad)
reality is that some lower end devices only support SD quality with a bitrate of 2
Mbps . Movies with a higher bitrate can be problematic on a lot of older (mainly

Android) devices..
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01:22 02:45

Options Play on Page load

Play in Loop (Except PDF)
Poster Frame From Current Frame v e

Navigation points

Either a frame from within the movie, or an image can be set as a poster frame. Basically,
you can also place any text block or image object(s) on top of the movie, e.g. "Click to
play movie" or a movie player icon as an indicator for the user. Likewise, if you insert an
MP3 audio file, you can place any type of button or text object on top of it. Clicking that
object on the iPad will play/stop the sound sample.

If you select "Place a video or audio file" from the media palette, that clip will be
embedded in your app.

You can also add a video clip that will be streamed using the Place a video from a URL
option. Obviously, if you select this option, the user needs to be online when trying to
access the movie.

When a video or audio clip is selected in InDesign, the Twixl Publisher palette also allows
you to control the settings relevant for the tablet app.
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¢ Twix| Publisher 15.3

< MOVIE

Show Movie Controls
Play In A Loop
Play On Page Load
Delay (sec) _
Play Full Screen

Return To Poster Frame After Playback

Stream Movie

Requires the Twixl Distribution Platform

1. Show Movie Controller: Provides the user with the standard movie controller options
to play/pause etc.

2. Play In A Loop: Provides a continuous playback of your movie clip.

Play on page load: Will automatically start a movie clip when a user navigates to that

page, and you can set an optional delay for the movie to start.

4. Play Full Screen: Will automatically play the movie in full-screen mode when started
(movies that don't automatically play full screen can always be zoomed using the
movie controller options).

5. Return to poster frame after playback: Does exactly that.

Stream Movie: If you are adding a movie to a publication that will be added to a kiosk

app on the Twixl Distribution Platform, checking "Stream Movie" will transparently

make it available for streaming, so that the movie does not take up valuable space in
the app.

w

o

Q¢ ABOUT PUBLIC vs. PRIVATE
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When you link Vimeo or YouTube inside a Twixl app, that video needs to be
available for everyone. Videos that have privacy settings enabled, will not
work.

Twixl Publisher 15.3

4 ASSIGN ELEMENT

The element you've selected can be used for different types
of interactive elements. Please select the type of interactive
element you want to use:

Web Viewer

Web Overlay Button
Image Sequence
Panorama VR
Map Widget
YouTube Movie
Vimeo Movie

Raw HTML

When drawing a rectangle frame, you can select the element to be a YouTube or a
Vimeo movie.
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Twixl Publisher 15.3

4 VIMEO MOVIE

V[T NP 46368458

Show Title

Show User's Byline
Show User's Portrait
Play On Page Load
Play In A Loop

Unassign As Vimeo Movie

Just enter the ID of the Youtube or Vimeo video in the Video ID field. You can select
exactly the same options that are available for an embedded movie.
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Audio

Easily add sound clips.

« Sound can be embedded in the publication via the Window -> Interactive ->
Media palette.

* You can add a sound clip encoded in the MP3 format.

« If you insert an MP3 audio file, you can place any type of button or text object on top of
it. Tapping that object on the device will play/stop the sound sample.

- If you select "Place a video or audio file" from the media palette, that clip will be
embedded in your app.

« When an audio clip is selected in InDesign, the Twixl Publisher palette also allows you
to control the settings relevant for the tablet app.

O—

[ D) 00:00 03:20

Options Play on Page load

Stop on Page Turn

Play in Loop (Except PDF)

Poster Frame None v
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Twix| Publisher 15.3

< SOUND

o Play In A Loop
e v Play On Page Load

Delay (sec) _

1. Play in A Loop: Provides a continuous playback of your sound clip.

2. Play On Page Load: Will automatically start a sound clip when a user navigates to that

page, and you can set an optional delay for the sound clip to start.
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Web viewers

Add dynamic web content to your publication.

Any rectangle on a page can be turned into a Web Viewer. A web viewer allows you to
add dynamic web content to your application. Integrate live content such as a Twitter
feed, integrate HTML5 apps or animations.

Create arectangle, then use the Web Viewer panel to enter the URL of the web page you
want to display within its boundaries.

Embedded content will always be available, even when a user is offline.

All local content, including assets, JavasScript, etc,, should be placed in a WebResources
folder within the folder where your InDesign book or document is located. The folder will
be created by the plug-in automatically when you define a Web Viewer for the first time.
You can then select Show WebResources... to navigate to that folder in the Finder. Note
that the contents should not be zipped, and should be placed there as is. You can
organize several embedded web viewers by creating different subfolders in the
WebResources folder.

Once you have copied all your html content and assets to that location, use the ".."
button in the Web Viewer panel to select the index page of your HTML content.

The URL will look like the example below:

webresource://index.html

webresource://subfolder/index.html

Q TIP:
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Use embedded web content to integrate HTML5-based animations.

¢ ABOUT WEBRESOURCES:

For more info about the wWebResources folder, see this KB-article.

¢ Twixl Publisher 15.3

4 WEB VIEWER

URL to Display:

https://help.twiximedia.com

- Y Allow User Interaction
v Open Links Inline
Show Scroll Bars
Transparent Background

Show Loading Indicator

Show WebResources...

Unassign As Web Viewer

1. Allow User Interaction: Configures whether a user can interact with the content or
not.

2. Open Links Inline: Will open all links in that same web viewer window - if this is
unchecked, tapping links in a web viewer will open the browser pop-up window (this
is the same pop-up window as the one triggered by http hyperlinks).

3. Show Scroll Bars: Whether or not to show scroll bars when scrolling through the web
viewer.

4. Transparent Background: Allows you to display web content transparently on your
InDesign background. In order for the transparency to work properly, however, the
HTML source must not have a background color.

5. Scale Content to Fit: If you want the width of the content to be adjusted to the width of
your web viewer. NOTE: Some web pages may not resize properly.
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If you want to add a link to a page in your publication from within a web viewer window,
you can do so by creating an HREF like the one below:

tp-pagelink://{article name}/{page number}
An example would be:

<a href="tp-pagelink://TOC/3">

Custom URL Scheme Function

t les th rrent view, whether visibl
tp-toolbar://toggle oggles the curre ew, whether visible

or invisible.
tp-toolbar://show

tp-toolbar://hide

tp-store://show

For an overview of all custom URL schemes for Twixl Publisher, check this article.

Displaying a PDF in a web viewer (either embedded or online) is possible only on the iPad.
To achieve a similar result on Android, you may need to create a web hyperlink to the
PDF.

You can also decide to open a URL in the device browser, e.g. if you want to allow readers
to save a PDF.
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Sometimes you may want to display embedded web content if a reader is offline, and
online web content if the reader is online. Check out this article to learn how this can be
done.

If you want to quickly add a snippet of HTML code, you can select Raw HTML from the list
of elements and just paste the code in the 'Raw HTML' field. There is no need to create
separate html pages in the WebResources folder.

The Requires an internet connection option allows you to check whether a user is online
first.

Twixl Publisher 15.3
4 RAW HTML

Paste your Raw HTML below:

Requires an internet connection

Unassign As Raw HTML
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Web overlay buttons

Instead of using a URL hyperlink to open a browser window on top of the whole
publication, or displaying web content within your page using a web viewer, you can
also choose to display a ‘Web Overlay), i.e. a modal web viewer that is displayed on
top of your page. The 'Web Overlay’ will always be positioned at the center of the
page and add a level of transparency to the rest of the page.

To create a web overlay, first create an object that will serve as the button that triggers
the overlay. When the object is selected, click 'Web Overlay Button' in the Twixl Publisher
palette.

Twix| Publisher 15.3

< WEB OVERLAY BUTTON

o URL to Trigger:

https://twiximedia.com

Analytics Name Rleisli}

wian ) [
veign () |

Show Scroll Bars

Show Loading Indicator

Show WebResources...

Unassign As Web Overlay Button

1. URL to Trigger: Enter the URL to be displayed in the overlay here. Similar to Web
Viewers, web overlays can also be used to load embedded HTML content. All local

content, including assets, JavasScript, etc., should be placed in a WebResources folder

within the folder where your InDesign book is located. You can select "Show
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WebResources" to navigate to that folder in the Finder. Once you have copied all your
html content and assets, use the ".." button in the Web Overlay panel to select the
index page of your HTML content.

2. Analytics Name: Enter a reference that will be used in the analytics information.

Width and Height: Enter the size of the web overlay (in pixels) here.

4. Background color: The color of the layer that will be placed on top of the content
outside the web overlay.

5. Opacity: Opacity of the transparent layer.

Allow User Interaction: Configures whether a user can interact with the content or

not.

7. Show Scroll Bars: Whether or not to show scroll bars when scrolling through the web
viewer.

8. Show Loading Indicator: Can be used to provide the user with some feedback while
the page is loading - typically this will be used only for external and not for embedded
content.

w

o

Embedded content will always be available, even when a user is offline.

All local content, including assets, JavaScript, etc,, should be placed in a WebResources
folder within the folder where your InDesign book or document is located. The folder will
be created by the plug-in automatically when you define a Web Viewer for the first time.
You can then select "Show WebResources..." to navigate to that folder in the Finder. Note
that the contents should not be zipped, and should be placed there as is. You can
organize several embedded web overlays by creating different subfolders in the
WebResources folder.

Once you have copied all your html content and assets to that location, use the URL to
trigger ".." button in the Web Overlay button panel to select the index page of your HTML
content.

The URL will look like the example below:

webresource://index.html

webresource://subfolder/index.html

¢ ABOUT WEBRESOURCES:

For more info about the WebResources folder, see this KB-article.
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Map

Add a map with ease

Twix| Publisher 15.3

4 MAPS WIDGET

Address to Show:

ﬂ Kortrijksesteenweg 1144 N, 9051 Gent, Belgium

Info Window Contents:

9 Twix| media
O

Unassign As Maps Widget

1. Address: Enter the address here like you would in the search bar

on http://maps.google.com or the Apple Maps app.

2. Info window: here you can enter the text that you want to display for that location.
3. Display As: allows you to select the map type.
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Animations

How to integratie animations in your InDesign content.

HTML5 animations can be created with several tools, like:

« Adobe Animate
« Tumult Hype

Twixl Publisher has direct support for the .oam file format used by Animate (and which
Tumult Hype can also export to). These .oam package files can be added to InDesign via
simple drag 'n’ drop, and InDesign will then also display a preview of the animation.

Q TIPS:

« Always create responsive projects or create your animation with the desired width
and height (as it will be used in InDesign).

« We strongly advise you to use a .html export together with a Web Viewer or Web
Overlay Button. It's less unpredictable and what's even better: You can test your
animation easily by testing it in every browser (desktop, iOS, Android).
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Nested Interactivity

Twixl Publisher allows you to embed certain interactive elements within scrollable
content or within a slide show.

The following types of nested interactivity are supported in scrollable content or in slide
shows:

 action buttons, hyperlinks and web overlay buttons
e audio

e video

« web viewers

« .oam files

« panorama VR

© NOTE:

Placing scrollable content inside an MSO (slide show,...), or putting an MSO inside
a scrollable content area is not supported. Nor is a scrollable inside a scrollable,
or an MSO within an MSO.

For nested interactivity in scrollable content, group the scrollable content itself with the
extra interactive element(s), before selecting 'Paste Into’ to paste the grouped content
into the scrollable frame.

For nested interactivity in a slide show, group the extra interactive element(s) with an
image that you want to add to the slide show, before converting it to a multi-state object.
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The order of interactive elements

How the plug-in handles multiple stacked interactive elements.

When the plug-in creates an export, each page will consist of:

- abase layer with the base image (all non-interactive content)
- an extra layer per interactive overlay

All interactive overlays are placed on top of the base layer in a specific pre-determined

order:

base layer (bottom)
movie

sound

web viewer

web overlay

image sequence
scrollable
full-screen image
slide show

10. web link

1. page link

12. button action (top)

©ONOD O A WN -~

¢ REMINDER IN INDESIGN:

Our templates in InDesign have all these overlays on board as layers. You are not

required to use them, but in any case it is a handy way to remind you to the
exact order of interactive elements!
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> Buttons

> Page Links

> Web Links

> Slide Shows & Full Screen Images
> Scrollable Contents

> Image Sequences

> Web Overlay Buttons

> Web Viewers & Widgets

> Sounds

> Movies

o
o
o
o
o
o
o
o
o
o
o

> Base Layer

Page: 1, 11 Layers
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Preflight, Preview, Share
& Export
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Preflight

When creating a preview, sharing or exporting a publication, Twixl Publisher performs a
number of preflight checks.

The preflight process will check the following items:

« Missing linked items (images, ...)

+ Missing fonts

« Image resolutions based on the alternate layout

« Page sizes

+ Alternate layout names

+ Alternate layout page counts

« Size of scrollable contents

- Multistates (to see if they don't exceed the page size)

« Image Sequences (source folder, does it contain image files, the correct file format,
image sizes, ...)

- Buttons (unsupported events, ...)

Depending on the severity, the preflight will generate either a warning (and allow you to
continue), or generate an error (in which case you cannot continue until the problem is
fixed).

r A

v Preflight Warnings (17)

~ TOC.indd (8)
Link "lieven.jpg" on page 1 has an effective resolution of 206 ppi where a minimum of 280 ppi is sug¢
Link "ijsland.jpg" on page 1 has an effective resolution of 206 ppi where a minimum of 280 ppi is sug
Link "alex.jpg" on page 1 has an effective resolution of 206 ppi where a minimum of 280 ppi is sugge
Link "TOC_logo_twixl.jpg" on page 1 has an effective resolution of 206 ppi where a minimum of 280 |
Link "lieven.jpg" on page 1 has an effective resolution of 226 ppi where a minimum of 280 ppi is sug¢
Link "ijsland.jpg" on page 1 has an effective resolution of 226 ppi where a minimum of 280 ppi is sug
Link "alex.jpg" on page 1 has an effective resolution of 226 ppi where a minimum of 280 ppi is sugge
Link "TOC_logo_twixl.jpg" on page 1 has an effective resolution of 226 ppi where a minimum of 280 |

~ Studio.indd (2)
Link "VR.jpg" on page 1 has an effective resolution of 267 ppi where a minimum of 280 ppi is sugges

Link "121203_favorite_toy.jpg" on page 1 has an effective resolution of 267 ppi where a minimum of

Cancel Continue...
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In the plug-in preferences, you can select whether warnings are displayed when doing a
preview, or when sharing and exporting. If you uncheck both, then Preflight will only bug
you when it encounters an error and is unable to continue.

r B
Preferences

Export Cache

Cache Size (GB) -

Current Size 64 bytes

Preflight
Show warnings during preview

Show warnings during sharing and exporting

Options
[J Enable Debugging Mode
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Preview InDesign content in the simulator
or on a device

You can preview the result of your interactive InDesign content either in the iOS
simulator (on macOS only) or in the Twixl Viewer Classic app running on an iOS or
Android device on your Wifi network.

Device Name Device Type Twixl Version IP Address

iPad 8th generation (14.5) iPad Retina 15.3 iOS Simulator
iPad Air 4th generation (14.5) iPad Retina 15.3 iOS Simulator
iPad Pro 11 inch 3rd generation (14.5) iPad Retina 15.3 iOS Simulator
iPad Pro 12.9 inch 5th generation (14.5) iPad Retina 15.3 iOS Simulator
iPad Pro 9.7 inch (14.5) iPad Retina 15.3 iOS Simulator
iPhone 11 (14.5) Phone Small 15.3 iOS Simulator
iPhone 11 Pro (14.5) Phone Small 15.3 iOS Simulator
iPhone 11 Pro Max (14.5) Phone Small 15.3 iOS Simulator
iPhone 12 (14.5) Phone Small 15.3 iOS Simulator

iPhone 12 Pro (14.5) Phone Small 15.3 iOS Simulator
iPhone 12 Pro Max (14.5) Phone Small 15.3 iOS Simulator
iPhone 12 mini (14.5) Phone Small 15.3 iOS Simulator
iPhone 8 (14.5) Phone Medium 15.3 iOS Simulator
iPhone 8 Plus (14.5) Phone Large 15.3 iOS Simulator
iPhone SE 2nd generation (14.5) Phone Small 15.3 iOS Simulator
iPod touch 7th generation (14.5) Phone Small 15.3 iOS Simulator

When selecting Preview for an article or publication from the plug-in, you are presented
with a list of devices running the Twixl Viewer on the local Wi-Fi network, as well as a list of
simulators (on macOSs only). So if you want to preview on a device, open the free TwixI
Viewer Classic app first, then select Preview from the Twixl Publisher plug-in palette
(whether for a single article or for a complete publication).

If the device you are looking for does not appear in the list, you can select Use IP
address... to manually enter the IP address listed in the bottom toolbar of the Twixl Viewer
window on your device.
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Selecting Preview in the macOS app presents a popup sheet similar to the list sheet in
InDesign.

Article-based app
Twixl User:

Twixl Project:

® InDesign article or publication

Select a Twixl .article or .publication document

Select Document...

Device Name

iPad 8th generation (14.5)
iPad Air 4th generation (14.5)
iPad Pro 11 inch 3rd generatio...

iPad Pro 12.9 inch 5th generati...

iPad Pro 9.7 inch (14.5)

iPhone 11 (14.5)

iPhone 11 Pro (14.5)

iPhone 11 Pro Max (14.5)

iPhone 12 (14.5)

iPhone 12 Pro (14.5)

iPhone 12 Pro Max (14.5)
iPhone 12 mini (14.5)

iPhone 8 (14.5)

iPhone 8 Plus (14.5)

iPhone SE 2nd generation (14.5)
iPod touch 7th generation (14.5)

Use IP Address... Reload

Create in InDesign

Device Type

iPad Retina
iPad Retina
iPad Retina
iPad Retina
iPad Retina
Phone Small
Phone Small
Phone Small
Phone Small
Phone Small
Phone Small
Phone Small
Phone Medium
Phone Large
Phone Small
Phone Small

Preview

Twix| Version

15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3
15.3

IP Address

iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator
iOS Simulator

Cancel
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In order to test whether there are any network issues, go to your browser and enter the
following URL:

http://[IP address of tablet device] :53652/
eg.
http://192.168.1.10:53652/

You should get a result with the device type and the Twixl Viewer version number like:

"info": "Twixl Publisher Helper 14.0 build 36460"

@ IMPORTANT NOTE:

If a soft- or hardware firewall is active on your network, and you seem to be
unable to send a preview to a device, make sure to ask the network
administrator to open TCP ports 53652 & 53654 .
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(192.168.0.238)

« Twixl Viewer Classic for iOS (iPads & iPhones) is available for download from the App
Store.

- Twixl Viewer Classic for Android (tablets and phones) is available from Google Play.
« A download link is available directly from the Twixl Publisher plug-in window as well.
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The Fruit Company

Documentation

Report a Problem

Load Sample Publication

Settings

Twixl Viewer Classic 15.2 build 36883

Tap the "i" icon in the bottom right corner to bring up the info menu.
Go to the documentation.

Report a problem (sometimes used for troubleshooting purposes).
Download a sample publication.

Go to the Twixl Viewer Classic settings in System Settings.

Version and build number.

OO0k, wWN -
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Sharing an article or publication

Sharing an InDesign article or publication with a client, either from the plug-in or from
the macOS app, is just as easy a creating a Preview.

Share your publication with someone else.

Arficle |
Page |

Select Document...

Your Email: publisher@theagency.com

Your email address

Share With: reviewer@theclient.com

Email address of who you want to share your file with

Message: Here is a first version of your digital publication. Let me
Optional  know what you think!

For a quick overview, check out the video below.

+ Select Share either from the plug-in panel or from the macOS app
» Enter the e-mail address of sender and receiver and an optional message
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Twixl Publisher 15.3

Publication Article

Properties Publication Article

Preview Publication Article

Publication Article

Publication Article

Separate Articles

Alternate Layouts

Preferences

Share Publication

Publication

File Name @ Avantgand.indb

Sharing Options
\CUIASGEN publisher@theagency.com
Share With | reviewer@theclient.com

\[ISFTX0 Here is the first version of your digital publication. Let

me know what you think!

« After clicking "OK’, the publication will be uploaded to Twix| servers
» The sender and receiver will get an e-mail confirmation when the upload has been
processed
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« The sender still has the option to remove the publication

000 T T € - B | * v B Moeto.
nbox - TWIXL MEDIA 174
Thanks for using Twix Publisher - you shared "Avantgand_buildtest” with demo@tuixim... ~ Details
To
TWIXL PUBLISHER

/4 "Avantgand_buildtest" shared with
demo@twiximedia.com

Here i the first version of your digital publication! | 5
k% Publication
Avantgand_buidtest
Will be deleted on
2020-03-12 04:09:17
Download link
twiximedia
As 500n as the recipient has downloaded your publication, you will receive a

confirmation email

Click on the link below if you wish to remove this shared publication,

REMOVE THIS SHARED PUBLICATION
44N

« If the receiver has not yet installed the Twixl Viewer, the confirmation message
contains download links for Twixl Viewer Classic for iOS and Android.

+ Tapping the e-mail link "Open with the Twixl Viewer" on the device will open the viewer
and start downloading the publication.
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000 @ T € & = B | * v B3 Moeto..

e £ 1nbox-.EDIA | DEMO  17:40 .

~ shared "Avantgand_buildtest" via Tuix! Publisher

To: demo@twiximedia.com

TWIXL PUBLISHER

Here is the first version of your digital publication!

OPEN WITH TWIXL VIEWER CLASSIC

Important

only workona that has the Twix! Viewer
Classic app installed. You can find the download links below.

Download for i0S. Download for Android

Publication Avantgand_buildtest
Will be deleted on 2020-03-12 04:09:17

Download link download

Twixl media
Kortriksosteenweg 1144 N
Gent

Tol 432 4832525 77
info@twiximedia.com

2.3. Downloading the shared publication/article

« The sender will get a read receipt.
« All this happens without the need to create and manage an account..

00 T T « * > B~ B Moeto.

e E3inbox - TWIXL MEDIA  17:44
Download confirmation from demo@twiximedia.com for *Avantgand_buildtest” via Twixl..  Detalls
To:

TWIXL PUBLISHER

DEMO@TWIXLMEDIA.COM
DOWNLOADED
AVANTGAND_BUILDTEST

Here is the first version of your digital publication!

Publication
Avantgand_buildtest
Download original file

Will be deleted on
12 march 2020

Download link

Twixl media
Kortriksesteenweg 1144 N
9051 Gent

Belgium

Tel 432 4932525 77
infoBtwiximedia.com

Create in InDesign Page 69



TI.I.IIXL LEARN & SUPPORT

Export

Export a single article or a complete publication or separate articles.

Once you have finalized your design, and have added the interactive elements you
wanted to include, you can select "Export article” or "Export Publication...”, available from
the Twixl Publisher palette.

Choose a destination for the export package and click OK. The Twixl Publisher plug-in will
now export all contents (possibly different versions for landscape and portrait, or
different form factors...)

Twixl Publisher 15.3

Publication Article
Properties Publication Article
Preview Publication Article

Publication Article

Separate Articles

@Publication @ Article

Alternate Layouts

Preferences

One InDesign document -> .article file

If you are exporting one article (possibly consisting of multiple pages), then a package
file with the extension .article will be generated.
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Complete InDesign book -> .publication file

For a complete export of an InDesign book, a package file with the extension .publication
will be created.

%

TIP ABOUT .PUBLICATIONS AND THE TWIXL PLATFORM:

When uploading a .publication file to the Twixl platform, it will automatically be
split in different .article content items during post-processing.

Complete InDesign book -> separate .article files

You can also export all members of your book (.publication ) as separate .articles .

v

TIP ABOUT EXPORTING AS SEPARATE ARTICLES:

InDesign has always been rather buggy when it's about exporting book files. Most
of the time they are caused by too many book files, too many fonts, etc. This also
influences the export or preview actions from Twixl Publisher. If your InDesign
book fails to export, you can also use this functionality to export separate articles
and avoid crashes.

ABOUT WINDOWS:

On Windows, the . article or .publication package file will appear as a folder.

PREFLIGHT:

When exporting an article or a publication, Twixl Publisher will always start a
preflight check first. If the plug-in detects a problem, depending on the severity,
you may or may not choose to continue the Export.
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Web Resources are used to embed (HTML) content in a .publication or .article . They
are also used in case of shared content (e.g. a movie that is used in different
.articles). Different Export options have different consequences. We explain them
briefly here:

1. Exporting a .article that is part of an InDesign-book: The Web Resources folder of the
InDesign-book will be completely integrated in the export of your each of the .article
packages.

2. Exporting a .article that is not part of an InDesign-book and was created
independently: The Web Resources folder of the InDesign-article will be completely
integrated in the export of your .article - and so will only contain those resources that
are required for that article.

3. Exporting as separate .articles (all articles of an InDesign-book): Each article will
include a complete copy of the Web Resources folder from the InDesign-book.

If your Web Resources folder doesn't contain a lot of huge files, you can choose for the
automatic management: exporting a complete .publication or exporting as separate
.articles will do just fine.

If all of your .articles contain a lot of huge files in the Web Resources folder, it's best to
create separate InDesign-articles and export all of them separately. You can also
combine them in a book-file afterwards, but you need to start with the creation of
separate Articles first (separate InDesign-files):

- Create all new Articles (via the Twixl Publisher plugin)

« Populate your Web Resources with the necessary files, only needed for each specific
.article

« Group all InDesign files in an InDesign .publication (an InDesign-book file)

« Use the Export as Articles so that you get an optimized .article export for each article.
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